Brake Test Software User Manual

• 01 - Brake Test SW Introduction
• 02 - Brake Test SW Auto Configuration
• 03 - Brake Test SW Live data
• 04 - Brake Test SW Viewing post processed data
• 05 - Brake Test SW Re-scanning data
• 06 - Brake Test SW Test setup
• 07 - Brake Test SW Obtaining results
• 08 - Brake Test SW Removing test lines
• 09 - Brake Test SW Analysing results
• 10 - Brake Test SW Glossary of terms
• 11 - Brake Test SW - Software Version
01 - Brake Test SW Introduction

Racelogic Brake Test Software is a stand-alone application specifically designed for Racelogic customers who are performing high dynamic brake stop tests using a VB3i or VBSS100.

The software is able to process both live serial data and recorded VBO files in order to generate results from either brake trigger or deceleration tests. This allows customers to perform multiple brake stop tests and view the results in a visually clear manner.

The software is more configurable, clearer and visual than the Report Generator brake stop test results in VBOX Tools.

Testing Environments

Due to the dynamic nature of a brake stop test a VBOX 3i should be set to its highest dynamic, most sensitive settings. To obtain good results from this it is essential that such a test is performed in an area of good, clear satellite reception (no high buildings, trees) with the antenna receiving a clear view to the sky with no obstructions (roof racks, etc).

How to set up equipment for live testing

To generate results from live serial data the software must be toggled to be Online under the Options tab.

[Image of software settings]

https://racelogic.support/01VBOX_Automotive/03Software_applications/Brake_Test_software/
Live data requires your software to be able to communicate with your VBOX. To do this a RLCAB001 serial cable must be connected to the serial port of your VBOX. This connection will be assigned a COM port by your computer. This relevant COM port must then be assigned under the **Options** tab.

https://racelogic.support/01VBOX_Automotive/03Software_applications/Brake_Test_software/
02 - Brake Test SW Auto Configuration

To get the most accurate and representative brake stop test results, the VBOX3i (or equivalent RL unit) should be setup in its most dynamic state.

This can be configured automatically through connecting the unit up to the software.

With the VBOX unit connected up to the software go to the **Options** tab, select **Configure Hardware**.

You should see a confirmation window pop-up once your unit has been successfully configured.

https://racelogic.support/01VBOX_Automotive/03Software_applications/Brake_Test_software/
03 - Brake Test SW Live data

When the software is in **online** mode the **Current Data** window on the right hand side of the screen can be used as a quick reference to see whether your setup is successful, and whether the system is ready to start performing brake stop tests.

If the window is green this indicates that the serial communication between the hardware and the software is successful, and that the VBOX has sufficient satellite lock.

Live data can also be monitored in the Current Data window, displaying Speed, satellite number, trigger status and up to four selected available CAN channels.
If the window is pink this means that either the connected VBOX has no satellite lock, or there has been a disruption in communication between the VBOX and software (No Comms).

https://racelogic.support/01VBOX_Automotive/03Software_applications/Brake_Test_software/
Current Data

<table>
<thead>
<tr>
<th>Speed (km/h)</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Satellites</td>
<td>0</td>
</tr>
<tr>
<td>Trigger</td>
<td>0</td>
</tr>
</tbody>
</table>

Results Current Test

<table>
<thead>
<tr>
<th>Trigger Speed (km/h)</th>
<th>102.60</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger Distance (m)</td>
<td>94.73</td>
</tr>
<tr>
<td>Corrected Distance (m)</td>
<td>90.00</td>
</tr>
<tr>
<td>Brake Distance (m)</td>
<td>78.55</td>
</tr>
<tr>
<td>Average Decel (g)</td>
<td>0.44</td>
</tr>
<tr>
<td>MFDD</td>
<td>5.58</td>
</tr>
<tr>
<td>Centreline Deviation (m)</td>
<td>+0.46</td>
</tr>
</tbody>
</table>

Satellites

No comms
CAN channels can be selected for viewing using the **CAN Set-up** option under the **Settings** tab. See below left.

To be selectable in the Brake Test Software, all CAN channels must be previously configured and set to log and 'send over serial' in the separate VBOX Tool Setup software.

Once enabled the selected channels appear in the “Current Data” display window, see below right.

![Refresh list]

![Current Data]

**Please note**, the Brake Test software configures your VBOX to 100Hz RS232 output. However, at this rate only certain channels are sent on the RS232 bus. If you choose to use RS232 rather than USB connection, you won’t be able to see all channels unless the user configures the VBOX to output serial data at 50Hz or less. This can be done in VBOX Setup via VBOX Tools software.
To generate brake test results from previously recorded data, the software must be set to Offline. This can be done by clicking on the **Options** tab and ensuring that the **Online** option is unchecked.

Load a VBO file in to the software by clicking on the **File** header tab at the top of the menu bar, and then clicking on **Load**.

The loaded file will then automatically be scanned and the results displayed.
<table>
<thead>
<tr>
<th>No.</th>
<th>Trigger Speed (km/h)</th>
<th>Trigger Dist. (m)</th>
<th>Corr. Dist. (m)</th>
<th>Brake Dist. (m)</th>
<th>Average Decel (g)</th>
<th>MFDD</th>
<th>CL Dev (m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>102.73</td>
<td>53.09</td>
<td>50.30</td>
<td>45.96</td>
<td>0.78</td>
<td>8.51</td>
<td>+0.00</td>
</tr>
<tr>
<td>2</td>
<td>99.60</td>
<td>47.18</td>
<td>47.56</td>
<td>52.06</td>
<td>0.83</td>
<td>8.15</td>
<td>+0.00</td>
</tr>
<tr>
<td>3</td>
<td>98.67</td>
<td>46.35</td>
<td>47.60</td>
<td>55.53</td>
<td>0.83</td>
<td>8.13</td>
<td>+0.00</td>
</tr>
<tr>
<td>4</td>
<td>98.71</td>
<td>45.95</td>
<td>47.16</td>
<td>55.95</td>
<td>0.83</td>
<td>8.46</td>
<td>+0.00</td>
</tr>
<tr>
<td>5</td>
<td>99.40</td>
<td>50.42</td>
<td>51.04</td>
<td>57.32</td>
<td>0.77</td>
<td>8.45</td>
<td>+0.00</td>
</tr>
<tr>
<td>6</td>
<td>99.86</td>
<td>46.68</td>
<td>46.81</td>
<td>47.96</td>
<td>0.84</td>
<td>8.58</td>
<td>+0.00</td>
</tr>
<tr>
<td>7</td>
<td>99.66</td>
<td>46.71</td>
<td>47.03</td>
<td>52.26</td>
<td>0.84</td>
<td>9.00</td>
<td>+0.00</td>
</tr>
<tr>
<td>8</td>
<td>98.58</td>
<td>41.86</td>
<td>43.08</td>
<td>53.73</td>
<td>0.91</td>
<td>9.28</td>
<td>+0.00</td>
</tr>
<tr>
<td>9</td>
<td>99.47</td>
<td>45.00</td>
<td>45.48</td>
<td>51.33</td>
<td>0.86</td>
<td>9.29</td>
<td>+0.00</td>
</tr>
<tr>
<td>10</td>
<td>99.06</td>
<td>44.50</td>
<td>45.34</td>
<td>52.58</td>
<td>0.87</td>
<td>9.22</td>
<td>+0.00</td>
</tr>
</tbody>
</table>
05 - Brake Test SW Re-scanning data

Under the **File** tab there is a **Rescan** button that can be used at any time once a file has been loaded in.

As it suggests, this button will re-scan the last loaded in data file and re-generate the results from it. This can be particularly useful if a number of runs from the test had been removed (deleted) from the analysis window previously.

https://racelogic.support/01VBOX_Automotive/03Software_applications/Brake_Test_software/
06 - Brake Test SW Test setup

Configuration of the setup criteria can be done using the **Test Set-Up** option, found under the settings toolbar.

---

**Adjust Units**

The units for speed, distance and acceleration can all be changed. These changes are reflected in all other windows in the software.

---

https://racelogic.support/01VBOX_Automotive/03Software_applications/Brake_Test_software/
Hardware Trigger

Configure a minimum speed for the hardware trigger to prevent unwanted trigger activation from being used in the results generation. Also configure whether the reported trigger speed is from the first measured sample after trigger activation, or a speed value interpolated between the reported and previous sample.

End Speed

Determine the speed that the brake test finishes and results are reported from.

Corrected Distance

Determine the ‘corrected distance start speed’, either by a specific value or an auto corrected value to the nearest 10 km/h (or mph).
**Smoothing**

Some input channels can be inherently noisy so require a certain level of smoothing to create representative results. Use option to apply desired levels of smoothing to speed, acceleration and all CAN channels in this option.

![Smoothing](image)

**Software Trigger**

Configure a starting speed for the software to create separate braking distances from.

This should be utilised when a hardware trigger is not available.

![Software Trigger](image)

**MFDD**

Adjust the speed values used in the MFDD calculations. Also chose between actual speeds or percentage of trigger/start speed.

![MFDD](image)

[https://racelogic.support/01VBOX_Automotive/03Software_applications/Brake_Test_software/](https://racelogic.support/01VBOX_Automotive/03Software_applications/Brake_Test_software/)
Centreline Deviation

Adjust settings for centre line deviation computation.

**Full period duration** - Time before trigger activation, this is what is used to calculate the centre line reference heading.

**Full Period std. dev. max** – The maximum allowed heading deviation during test.

**Average Heading Tolerance** – The allowable tolerance of heading change during centre line deviation.

**Std. dev. Warning threshold** – Heading deviation threshold before results displayed with red warning text.

Note: Centreline Deviation results in Red:

Centre line deviation results shown in Red indicates that the vehicle was not driven straight enough during the immediate time before the test start condition was met, exceeding the configured Full Period Standard Deviation threshold.
Brake or deceleration test results can be achieved by using either a hardware trigger or a software trigger. Once the software has detected one of these inputs it will calculate results for distance, deceleration and other parameters relative to the user configured Test Setup.

Toggle the hardware trigger on and off by using either the spacebar on your keyboard, or the Disable Trigger button found in the bottom right corner of the software.
A practical tool within the software application is the ability to delete selected runs from the data output. This enables any erroneous or unwanted results to be quickly removed from the data, making analysis clearer and more representable.

If you wish to remove all of the current data, then the **Reset** button can be used to do this quickly.
Results can be viewed and analysed in several forms using the Brake Test Software package, and any graphs and tables can be adapted to suit the customers' specific requirement for any given test.

Results from Last Recorded Test

Results of the last performed brake stop test will be shown in numerical form in the Results Current Test tab, or in a more visual representation in the Current Graph window. The Current Graph shows the live plot of user configured channels for the current test run.
The **Current Graph** window can be altered by making changes to the **Current Graph Set-up** page under the **Settings** option. In the setup, both axis can be altered, different data channels be selected and a reset value determined.

Collective Results

Figurative results are clearly laid out in a tabular form in the **Results** window. The test results by default will be shown in numerical order. The table can be toggled though by clicking on a desired column to order the test results by highest to lowest (or reverse).
Results can also be displayed in a much more visual representation using the **Bar Graph** window. This window displays all the measured results in a column bar graph form.

Results for Trigger Speed, Corrected Distance, Braking Distance and Average Deceleration are all shown here.

The graphs are also adjustable using the **Bar Graph Set-Up** option, under the **Settings** menu bar.
10 - Brake Test SW Glossary of terms

Centreline Deviation

Commonly used for applications such as measuring side wind susceptibility, and vehicle deviation during various manoeuvres; the centre line deviation function can be used to show the deviation of a vehicle from a specified centre line to an accuracy of between 1 and 2cm (over a 30 second time period).

The high accuracy, Doppler derived velocity channels are measured and used to determine the lateral deviation from a specified track heading at every sample using geometric theories. This calculated deviation (lateral displacement) is an accumulative distance measurement, so it is most accurate when measured over short periods of time.
The above diagram simply displays how the accumulative deviation from a given centre line (H) is calculated.

Once the centre line deviation value starts calculating (S1), it will initially take the heading value recorded by the Doppler shift, and create a heading difference value (h1), relative to the defined Centre line deviation heading. Knowing the velocity at which the vehicle was travelling between samples (v) allows a sample measured deviation distance to be accurately determined. Using trigonometric relationships, this deviation distance is calculated using the following equation.

\[(\text{Sin (heading diff)} \times \text{Speed(m/s)}) \times \text{sample time}\]

For successive samples a heading difference is then determined by comparing the current heading sample to the one
The sample measured deviations are then accumulated throughout the test to produce a final centre line deviation result.

**Corrected Distance**

The corrected distance measures the point at which the brake trigger is activated to the test end speed, corrected by multiplying the total distance by the ratio of the square of the trigger speed to the nominated 'corrected distance start speed'

Corrected distance =

\[
T_d \times \frac{\text{Nom Speed}^2}{\text{Trigger Speed}^2}
\]

Where:

\text{Nom Speed} = \text{a specific speed or the nearest 10km/h (or mph) of the trigger speed.}

In the real world it is very difficult for test drivers to hit the brakes at a set speed within 0.1km/h repeatedly. The Corrected trigger distance calculation compensates for the over, or under speed application and normalises the result to a set start speed value maintaining the original initial braking reaction time, as if the brakes had been applied at that exact set speed.

**MFDD**

This deceleration figure is used to show the maximum deceleration figure a vehicle can achieve. It is usually the deceleration between 80% and 10% of the trigger activation speed, the time at which the vehicle is loaded up and braking at its highest achievable level.

The MFDD is calculated by the following formula:

\[
\text{MFDD} = \frac{((v_{08})^2 - (v_{01})^2)}{25.92 \times (s_{01} - s_{08})}
\]

Where:

\text{v} _{08} \text{ is the speed at 80\% of the brake trigger activation speed.}

https://racelogic.support/01VBOX_Automotive/03Software_applications/Brake_Test_software/
v\_01 is the speed at 10% of the brake trigger activation speed.

s\_01 is the distance at which the speed is v\_01.

s\_08 is the distance at which the speed is v\_08.
11 - Brake Test SW - Software Version

The installed version of Brake Test Software currently being used can be checked by clicking on the About tab along the top menu bar.

Latest Software and Firmware versions are always available to download from our website.

https://racelogic.support/01VBOX_Automotive/03Software_applications/Brake_Test_software/